
Investit Decisions 
________________________________________________________________________________________________________________________ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Instruction Manual 
USA Edition 1.1 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
__________________________________________________________________________________________________________ 
 

Investit Software Inc. 
Toll free 877-878-1828 

North Vancouver BC 
Canada V7R 1M1 

investit@investitsoftware.com 
www.investitdecisions.com 

 
 



 2

 

Table of Contents 
 

 
INVESTIT DECISIONS. OVERVIEW............................................................................. 4 

Investment Analysis Examples.......................................................................................... 4 
Outsource (Make or Buy decisions) Examples................................................................... 4 
Keep or Replace Decision Examples................................................................................. 5 
Buy Versus Lease Decision Example ................................................................................ 5 
Real Estate Investment Analysis Example......................................................................... 5 
Buy versus Lease Real Estate Example............................................................................ 5 
Lease Comparison Analysis Example................................................................................ 5 
INTRODUCTION TO INVESIT DECISIONS ................................................................ 6 

The fastest way to learn Investor Decisions....................................................................... 6 
DOWN LOADING, INSTALLATION, MY ACCOUNT & PASSWORD ...................... 9 

Downloading & installing Investit Decisions ....................................................................... 9 
My Account..................................................................................................................... 10 
Changing your Password ................................................................................................ 10 
INVESTIT DECISIONS PANEL.................................................................................... 12 

Introduction..................................................................................................................... 12 
Investit Decisions Online Learning Center ....................................................................... 13 
The Investit Decisions Online Learning Center ................................................................ 14 
Auto Update.................................................................................................................... 15 
Setting up Company Information & selecting Report Preferences .................................... 15 
Setting up a Disclaimer Statement or Footnote................................................................ 17 
Selecting Report Preferences.......................................................................................... 18 
Importing a logo .............................................................................................................. 20 
Saving a Project.............................................................................................................. 24 
Using “Save As” to create scenarios................................................................................ 25 
Viewing Reports.............................................................................................................. 25 
Printing Reports .............................................................................................................. 26 
Incremental Cash Flow Report ........................................................................................ 30 
Currency Conversion ...................................................................................................... 35 
Selecting a template........................................................................................................ 36 
Criteria for selecting a template....................................................................................... 36 
Types of Investit Decisions.............................................................................................. 36 
Yearly versus Monthly Templates.................................................................................... 37 
Expenses Only versus Revenue and Expense Templates ............................................... 37 
ENTERING A PROJECT ............................................................................................... 40 

Introduction..................................................................................................................... 40 
PROJECT INFO. FOLDER ............................................................................................ 41 

Changing the Analysis Time Period................................................................................. 42 
Changing the Starting Date and Date Format .................................................................. 43 

INVESTOR FOLDER...................................................................................................... 45 
Entries ............................................................................................................................ 45 
Turn Off Tax Feature....................................................................................................... 45 
Tax Adjustment Grid ....................................................................................................... 46 
INVESTMENT FOLDER ................................................................................................ 47 

Introduction and Example................................................................................................ 47 
Inflate Button................................................................................................................... 48 
Half Year & Mid Month Conventions................................................................................ 49 
Declining Balance Depreciation Method .......................................................................... 49 
WORKING CAPITAL FOLDER ..................................................................................... 51 

Repayment of Working Capital ........................................................................................ 51 
Tax Implications.............................................................................................................. 51 
EXPENSES & REVENUE FOLDERS........................................................................... 52 



 3

Projection Wizard............................................................................................................ 53 
Using the Expenses & Revenue Folders ......................................................................... 57 
Entry Choices ................................................................................................................. 57 
Special Entry Choices. $ per Unit &Quantity & % of Revenue(s) or Expenses.................. 58 
$ per Unit & Quantity Entry Choice.................................................................................. 58 
% of Revenues(s) & % of Expenses Entry Choices ......................................................... 59 
Creating your own Entry Choices .................................................................................... 61 
Rearranging the Entry Choice List & the Default Entry Choice ......................................... 63 
Revenue & Expense Categories...................................................................................... 65 
FINANCE FOLDER......................................................................................................... 67 

Preface ........................................................................................................................... 67 
Features ......................................................................................................................... 67 
SALVAGE VALUE FOLDER ......................................................................................... 70 

Introduction..................................................................................................................... 70 
Income Tax Adjustment................................................................................................... 70 
REPLACEMENT DECISIONS (KEEP or REPLACE) UNIQUE FEATURES .......... 71 

Introduction..................................................................................................................... 71 
Keep or Replace Decision. Examples.............................................................................. 71 
Keep Template. Investment Folder.................................................................................. 72 
Preexisting Investments .................................................................................................. 72 
New investments............................................................................................................. 72 
Entering Preexisting and New Investments. Example ...................................................... 73 
Keep Template. Finance Folder ...................................................................................... 77 
Preexisting Financing...................................................................................................... 77 

CUSTOMIZING TEMPLATES ...................................................................................... 80 
Introduction..................................................................................................................... 80 
Creating and saving a new template................................................................................ 80 
My Templates ................................................................................................................. 81 
Renaming & Deleting My Templates ............................................................................... 82 
Customized Template Example....................................................................................... 82 
GRAPHS .......................................................................................................................... 83 

Operating Cash Flow ...................................................................................................... 84 
FILE MENU ..................................................................................................................... 86 

New Project .................................................................................................................... 86 
Open Project................................................................................................................... 87 
Close Project .................................................................................................................. 88 
Delete Projects................................................................................................................ 90 
Using “Save As” .............................................................................................................. 92 
Save as Template........................................................................................................... 93 
Rename Template .......................................................................................................... 94 
Delete Templates............................................................................................................ 95 
Import/Export .................................................................................................................. 96 
Importing a Company Logo ............................................................................................. 99 
2. Locate and select the logo and click on the “Open” button ..........................................100 
Project Images...............................................................................................................101 
EDIT MENU....................................................................................................................103 

Copy & Paste Client Information.....................................................................................103 
UTILITIES ......................................................................................................................104 

Auto Update...................................................................................................................104 
Backup/Restore .............................................................................................................104 
Backup ..........................................................................................................................104 
Restore..........................................................................................................................105 
DEFINITIONS & FORMULAS .....................................................................................106 
 



 4

INVESTIT DECISIONS. OVERVIEW 

 

Investit Decisions is a financial, capital budgeting, cost/benefit and engineering economic analysis software that 
can be easily adapted and applied to any industry and to non profit organization such as government, cities, 
hospitals and universities etc  
 

Using Investit Decisions you can carry out; 
 

1. Investment and cost/benefit analysis 
2. Keep versus Replace analysis (Equipment replacement decisions) 
3. Outsourcing analysis (Make or Buy decisions) 
4. Buy versus Leasing of equipment 
5. Real Estate Investment Analysis 
6. Buy versus Lease analysis. Real Estate 
7. Lease comparison analysis from a Landlord & Tenant perspective 
8. Incremental or differential cash flow analysis 

 
The following examples illustrate the versatility of Investit Decision. 
 
Investment Analysis Examples 
 
1. A city is considering expanding a community center. What are the costs and benefits? 
 
2. A company is considering replacing all their incandescent lights with CFL’s (compact fluorescent lights). What 

is the payback period and return on investment?  
 

Investit Decisions can be used to evaluate a wide variety of energy efficiency and conservation initiatives. 
 
3. A cement company has to move the cement 300 yards from one silo to another.  They can a) pump the 

cement through a pipeline or b) use a covered conveyor.   Which is the most cost effective? 
 
4. An organization is considering expanding their production facilities to generate more sales revenue. 
 

The organization can spend $11,000,000 to expand their New Jersey plant to increase the production and 
sales of Product A & B. What is there return on investment and is it acceptable? 
 
For $15,000,000 than can also add a new product called Product Z. In addition, if they spend $15,000,000 
they can lower the cost per unit cost of producing produce A and B resulting in additional savings. 
 
Should the organization invest $11,000,000 or $15,000,000?  
 

5. A company is considering relocating their plant. Possible locations are Tucson, Arizona or Austin, Texas. 
Which is the best location from an economic perspective?                                                                                

 
Outsource (Make or Buy decisions) Examples 
 
1. A city is considering outsourcing the servicing and repair of plant and equipment. Should they continue to 

service repair the plant and equipment or outsource? 
  
2. A manufacturer can invest in the equipment to make the cam shafts for a fork lift truck or they can outsource 

to China. Which is the most economical? 
  
3. A pulp mill consumes a large amount of electricity. Should they continue to buy from the utility company or 

install their own generating equipment and sell the excess capacity? 
 
 
4. A hospital is considering whether to continue processing the laundry or outsource to a laundry company. 
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Keep or Replace Decision Examples 
 
1. A hospital has an old X-Ray machine which breaks down on a regular basis. Should they replace the old 

equipment with a new, more productive X-Ray machine? 
 
2. A city is continually repairing an aging wooden bridge. Should they; 

a) Keep fixing the bridge? 
b) Replace with a new wooden bridge? 
c) Replace with a steel bridge? 
 

3. A manufacturing organization is considering replacing aging production equipment used to produce plastic 
bottles with a more technologically advanced model which will result in; 

 
• Less rejected products resulting in lower manufacturing costs per unit 
• The new computerized system allows faster set up and less down time 
• Increase in sales because of increased production capacity 
• Lower labor costs per unit 

 
Should they invest it the new equipment? 

  
Buy Versus Lease Decision Example 
 
Should we buy or lease our forklift trucks? 
 

Real Estate Investment Analysis Example 
 
Should we invest in real estate instead of leaving our money in the bank? 
 
Buy versus Lease Real Estate Example 
 
Instead of leasing should we purchase our own building and sub-lease 45% of the space? 
 
Lease Comparison Analysis Example 
 
Your organization has received proposals from three landlords to lease space in their buildings. Each offering 
different lease terms and conditions. In addition the cost of moving is different for each location. Which lease 
proposal is the best deal? 
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INTRODUCTION TO INVESIT DECISIONS 
 
In order to quickly learn how to use Investit Decisions there are a few basic concepts and things you need to 
know. These can be learnt quickly. 
 
Once you understand the basic concepts outlined in this manual focus on learning how to use 
“Projection Wizard” which is used project revenues and expenses. Projection Wizard is the heart of Investor 
Decisions.  
 
Once you have mastered Projection Wizard you can quickly enter simple or highly complex revenue and 
expenses projections and utilize the full power of Investor Decisions. 
 
The Projection Wizard instruction manual is available on the Investit Decisions Learning Center. 
 

 
 
The fastest way to learn Investor Decisions 
 
Investit Decisions come with a wide variety of examples, which are accessed from the Investit Panel by clicking 
on the ‘Investit Examples’ panel folder and then selecting and opening an example. 
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The input information with step by step instructions for each Investit example is available on the Investit Online 
Learning Center which can be accessed by clicking on the “Investit Online Learning Center” button on the Investit 
Panel. 
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A quick way to learn Investit Decisions is to; 
 
1. Open up an Investit Example 

 
 
2. View the folders and view the Reports and Graphs from the Report Menu 

 

 
 

Then; 
 
Go to the “Online Learning Center” and print out the corresponding example. The example includes all the input 
information followed by the step by step instructions on how to enter the project data. 
 
Follow the steps outlined in the example and enter the information into a new template. 
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DOWN LOADING, INSTALLATION, MY ACCOUNT & PASSWORD 
 

Downloading & installing Investit Decisions 
If you haven't already downloaded Investit Decisions go to http://www.investitdecisions.com/download and save 
the Setup file to your desktop.  
 
Installing Investit Decisions 

1. Windows XP or earlier. Double click on the "Investit_Setup.exe" and follow the installation instructions  
2. Vista 32 & 64. Right click on the "Investit_Setup.exe" select "Run as Administrator" and follow the 

installation instructions  
3. During installation process select your country (USA or CND) 

Activation and Registration  
Once Investit Decisions is installed you will have 21 days to Activate the program.  
 
To start the activation process, simply click on the "Activate" menu and select "Activate this Computer". Enter 
your Username and Password in the Investit Login menu. You can activate up to 2 computers in this way without 
assistance from Investit support service. 
 

 
 

http://www.investitdecisions.com/download
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My Account 

To access your account; 
 
1. login on www.investitdecisions.com and click on ‘My Account” 
 
2. Enter your Username & Password 
 

 
 
Changing your Password 
Once logged into your account following the above procedure, click on the ‘My Profile” link 

 
 
Scroll down the page to entry fields marked ‘Password’. Enter your new password and then enter it a second time 
in the ‘Confirm Password’ field. When finished click on Submit to save your changes. 
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Changing your password. Example 
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INVESTIT DECISIONS PANEL 

 
Introduction 
When you open Investit Decisions the first thing you see is the Investit Panel which allows you to; 

1. Select an Investit Template and start a project 
2. Select one of your own templates in the “My Template” folder 
3. Select an Investit Example 
4. Open a project that you have created and saved in “My Projects” 

 
The Investit Panel provides quick access to; 

1. Investit Auto Update 
2. Company Information 
3. Report Preferences 
4. Investit Online Learning Center 
5. Utilities such as Back Up and Restore 
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Investit Decisions Online Learning Center 

To help you learn how to use Investit Decisions quickly go to the Investit Online Learning Center by clicking on 
the “Investit Online Learning Center” button on the Investit Panel. 

 
Following is the Investit Online Learning Center 
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The Investit Decisions Online Learning Center 
 

 
 

The Online Learning Center consists of the following sections; 
 
1. Instruction Manuals explaining how to use Investit Decisions. You are currently viewing an Investit 

Instruction Manual. 
 
2. Examples which show the step-by-step examples on how to enter the Investit examples. This is a great way 

to learn Investit Decisions. 
 

3. Resources contains articles on investment analysis and other topics. 
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Auto Update 

Investit continually adds new reports, graphs templates and features. Auto Update allows you to download the 
latest updates. 
 
If you are connected to the web, and using Investit Decisions, you will be notified that an update is available and 
the text on the Auto Update date button will turn red when an Update is available.  
      
Setting up Company Information & selecting Report Preferences 

 
Before you start entering projects you should: 
 

1. Set up the information on your company in ‘My Company Information’ 
2. Select your ‘Report Preferences’  
 

Steps 

 

1. Enter your company and personal information 
2. Select your ”Report Preferences 
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1. Open Investit Decisions 
2. Click on ‘My Company Information’ button on the Investit Decisions panel  
 

   
 

 
 
3. Enter your company, personal information and a Footnote or Disclaimer Statement if appropriate 
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Setting up a Disclaimer Statement or Footnote 
 
There are two Disclaimer Statement options; 

 

1. Brief Disclaimer Statement or footnote that is printed at the bottom of each page. Enter this type of 
Disclaimer Statement in the My Company Information dialog screen. The footnote Disclaimer Statement 
is limited to 130 characters. See example below 

 

2. Expanded Disclaimer Statement that is printed as a separate report from the Report Menu. Use this if 
your Disclaimer Statement is longer than 130 characters.  Click on the Disclaimer Statement button and 
enter your Disclaimer Statement in the Disclaimer Statement dialog screen. The Disclaimer Statement 
can then be printed from the Report Menu  

 

 
 

 
A common approach with Disclaimer Statements is to use the brief Footnote Disclaimer Statement to direct the 
reader to the expanded Disclaimer Statement, which is separately attached to the presentation package. 
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Selecting Report Preferences 

 
Use Report Preferences to select what information you require to be printed on the reports and your preferred 
font. Report Preferences can be accessed from the Investit Panel or from the Report Menu after selecting and 
opening a Template. 

 

  
 
Report Preferences allow you to select the company and personal information to be printed on: 
 

• The Title Page 
• All Reports 

 
and allows you to select your preferred Font. 
 
As an example, you may elect to print your company’s name, telephone number but not the address. 
 

1. Click on ‘Report Preferences’ on the Investit Decisions  
 
2. Select the appropriate folder tab and check the information you wish to include in the ‘Title Page’ 

and ‘All Reports’ 
 

3. Select the desired Fonts on the Fonts tab 
 



 19

Report preferences selection dialog 
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Importing a logo 

 

Following are the steps for importing your company logo. Acceptable file formats are; 
 

.png   .jpg  .gif 
 
1. Select “Company Logo” on the File Menu then click on the “Add” button 
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2. Locate and select the logo and click on the “Open” button 
 

 
 

3. Click on the “Ok” button 
 

 
 
The company logo is now displayed on all reports 
Example 
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STARTING A PROJECT, SAVING, VIEWING REPORTS & EXPORTING TO EXCEL & PDF 
 

The steps involved in carrying out an analysis are; 
 

1. Open Investit Decisions 
2. Select and open the appropriate template 
3. Enter the data in the Folders  
4. Save the Project 
5. View or Print the reports 
6. Reports can be exported to Excel or PDF 
 
Open Investit Decisions and select and open the appropriate template on the Investit Template list 
 
Partial list of Investit Decision’s templates 
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1. Enter the data in the Folders 
 

The analysis is carried out by selecting a folder and entering the data in the folder. 
 
An example of the information entered in the Investor Folder   
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2. Save the Project 
 

Once you start a project and start entering data, use “Save” to give the project a name and save the project 
 
Saving a Project 
 
1. Select “Save Project” from the File Menu 

 
 

2. Give the project a name and save. You can also enter a description of the project 
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Using “Save As” to create scenarios 

 
You may wish to run different scenarios for the project. As an example; 
 

• Optimistic Forecast. Run 1. 
• Medium Forecast. Run 2 
• Pessimistic Forecast Run 3 

 
1. Use “Save As” to create a duplicate project with a new project name 
2. Make the desired changes 
3. Save using “Save As” 

 
Viewing Reports 
Once the data is entered you can view a Report or Graph from the Reports Menu and then print or export to Excel 
or to PDF.  
 
Following is an example of the “Operating Cash Flow Yearly” report. The report was selected from the report 
menu. 
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Example. Operating Cash Flow Report Yearly 

 
 
Printing Reports 
 
A group of reports can be selected and printed from the Reports menu as follows; 
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Project Comparison Report 
 

Up to four projects can be compared side by side. 
 
Steps involved in selecting the projects for the Project Comparison Report. 

 
1. Select the Project Comparison Report on the Report menu 

 
 
2. On the Project Comparison Report dialog click on the “Add” button to display the Report Selection List. Select 

the Project and click ‘Ok” Repeat the process to add another project. 
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3. The diagram below shows selected projects to be displayed in the “Project Comparison Report” 
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Sample Project Comparison Report 
 

 
 
Interpretation and Decision 
 
The organizations minimum acceptable return (IRR) is 12.00% before tax. 
 
On initial inspection it appears that both options A & B exceed the desired return (IRR) of 12.00% and they should 
proceed with Option B and invest the $12,260,000. This conclusion is incorrect. 
 
They should choose the option that; 
 
1. Provides the highest Net Present Value 
2. The highest Benefit to Cost Ratio 
 
Which is Option A the $8,200,000 investment. 
 
This can be clearly seen using Incremental Cash Flow Report 
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Incremental Cash Flow Report 

 

The Incremental Cash Report allows one project to be subtracted from another to generate the incremental cash 
flow. Up to 4 projects can be added and subtracted. 
 
As an example, an organization is considering expanding their New Jersey Plant and has two options. Option A is 
to invest $8,200,000 and increase the sales of Products A & B. Option B is to invest $12,260,000 and increase 
the sales of products A & B plus add a new product Z. 
 
This is called a “Mutually Exclusive Investment” The organization can invest $8,200,000 for option A or 
$12,260,000 for Option B but cannot invest in both Option A and B. 
 
The question is “What is the return on the additional $4,060,000 required for Option B and is the return (IRR) 
acceptable? This is called “Incremental Cash Flow Analysis”. 
 
TIP. Always select the largest investment first for the Incremental Cash Flow Report. In this example select 

Option B for $12,260,000 first, and then subtract Option A the $8,200,000 investment as follow.. 
 
Steps 
 
Select the Incremental Cash Flow on the Report menu 
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Enter; 
 

Investor’s Marginal Tax Rate 
Discount Rate 
Short Term Rates 

 
On the “Incremental Cash Flow Report” dialog click on the “Add” button to display the Report Selection List. 
Select the Project and click ‘Ok”. Repeat the process to add another project.  The Option B project was selected 
first because it the investment of $12,260,000 is larger than the $8,200,000 investment for Option A. 
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The selected projects for the Incremental Cash Flow Report are: 
 

 
 

Click on the “Preview Report” button to display the “Incremental Cash Flow Report” 
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Interpretation and conclusion 
 
If the organization’s minimum acceptable rate of return (IRR) is 13.00%, both Option A and Option B seem to be 
acceptable because they both provide a return (IRR) higher than 13.00%.  
 
However, the return (IRR) on the incremental investment of $4,060,000 for Option B is 3.42% which is far below 
the minimum acceptable value of 13.00%. In this case Option B should be rejected and Option A accepted. 
 
The other approach is to select the project with the highest Net Present Value (NPV) which is Option A 
 
Both the ‘Incremental Cash Flow” approach or choosing the option with the highest Net Present Value (NPV) will 
result in the same choice when dealing with mutually exclusive investments.
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Exporting Projects to Excel or PDF 

Exporting Reports to MS Excel allows customization of the reports or the application of additional calculations.  

 Note: Exported Reports contain the results not the formulas. 

The Excel or PDF report files can be sent as e-mail attachments for others to view and print out the reports. 

The selected reports can be quickly exported to Excel or PDF as follows; 
 
1. Select on the Reports menu either “Export Reports to Excel” or “Export Reports to PDF” then select the 

reports to be exported  and click on the Export button and follow the instructions. 
 
2. Name and save the file  on the desktop or select a folder using the Window’s browser 
 
3. You can now e-mail the Excel or PDF file. 
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Currency Conversion 

 
Enables reports to be converted to another currency. 
 
1. Select “Currency Conversion” from the Report Menu and complete the currency conversion screen 
2. Enter; 
 

• The Conversion Rate 
• Currency Description 
• Select the currency symbol 

 
 

 
 

 
 
 
Example report showing the conversion from USD to Canadian dollars 
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Selecting a template 
The first step in starting a project is to select the appropriate template for your analysis. 
 
Partial List of Templates 

 
 
 
Criteria for selecting a template 

In choosing a template, there are three considerations that affect the template choice; 
 

1. What type of decision are you making?  E.g. Replacement Decisions (Keep or Replace) 
 

2. Do you want to project revenues and expense monthly or yearly? 
 

3. Does the analysis involve “Revenue & Expenses“ or only “Expenses” 
 
Types of Investit Decisions 

 
Investit Decisions offers the following analysis; 

1. Investment Analysis 
2. Replacement Decisions. Keep or Replace? 
3. Outsourcing Decisions. Make or Buy? 
4. Buy or Lease? 
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Yearly versus Monthly Templates 

 
There are two ways to project revenues and expenses 

1. Yearly  
2. Monthly 

 
Yearly Templates: Revenues and Expenses are projected yearly 
 
Monthly Templates: Revenues and Expenses are projected monthly 
 
Yearly templates are faster to use than monthly templates.  
 
Select a monthly template if; 
 

1. Revenue and expenses change during the year 
2. Detailed monthly cash flows are required 
3. Sales or expenses are seasonal and depend on the time of the year and require monthly entries and 

projections 
 
Expenses Only versus Revenue and Expense Templates 

 
The third consideration in choosing a template is whether there is a need to enter revenues (or cost savings) as 
well as expenses 
 
Revenues are generally not relevant for the following types of analysis. Generally choose a template with 
“Expenses Only” for; 
 

Replacement Decisions. Keep or Replace? 
Outsourcing Decisions. Make or Buy? 
Buy or Lease 
 

Investments can be classified as “Service Projects” or “Revenue Projects” 
 

Service Projects: 
Revenue is not dependant on the choice of the investment.  
Example: An organization’s revenue is not affected if they decide to lease instead of buy a photocopier. 
 
Revenue Projects:  
Projects where the revenues generated depend on the investment choice.  
Example: Investing in new plant and equipment to produce and market a new product line which 
generates increased revenue. 
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Occasionally there is a need to choose a templates with “Revenue and Expenses” if there a revenue or cost 
savings involved for following templates; 
 

Replacement Decisions. Keep or Replace? 
Outsourcing Decisions. Make or Buy? 
Buy or Lease 
 

Examples 
 

1. An organization is evaluating whether to make a component or outsource. If they outsource they can 
sublease the excess space in their building which will generate additional revenues. In this case, they 
would select the “Outsource Revenue and Expenses” template instead of the “Outsource Expenses Only” 
template  

 
2. An organization is exploring ways to reduce their energy cost and is considering replacing all the internal 

and external lights with more efficient, longer lasting lights. They would use a Replacement template with 
Revenue and Expenses because of the energy cost savings generated by the more efficient and longer 
lasting light bulbs. The cost savings are treated as revenue. 
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Invest (Investment Analysis) templates 
 

1. If the investment incurs operating costs but does not affect revenues, choose an “Expenses Only” 
template 

 
Example. 
An organization needs to install equipment to reduce carbon emissions and is evaluating several different 
equipment suppliers. The decision involves investment, installation and operating expenses.  
 
The decision does not affect the organizations revenues. They would use an “Invest Expenses Only 
template” because there are no revenue or cost savings involved. 
 

2. If the investment generate revenues or cost savings, choose a “Revenue & Expenses” template 
 

Example. 
An organization is considering increasing revenues by investing in new plant and equipment to develop a 
new product line. 
 
In this case they would use the “Invest Revenue & Expenses” yearly or monthly template. 
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ENTERING A PROJECT 

 

Introduction 
 
This section illustrates the basic steps involved in entering a project using the Invest Decisions Monthly Template 
and the example Investit Example “A1 Invest Rev & Exp Monthly Proj. Part A” 
 
The step by step instructions for entering this example is available from the Investit Online Learning Centre. 
Select “Investment Analysis Monthly” 
 

 
 
Open the Investit Example “A1 Invest Rev & Exp Monthly Proj. Part A 

 
 
The process is to select each Folder and enter the data working from left to right. 
 

 
 
 



 41

PROJECT INFO. FOLDER 
 
Enter the Project Name and Description 
 
You can change the “Analysis Time Period” the “Starting Date” and “Date Format” which is explained below. 
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Changing the Analysis Time Period   

You can increase or decrease the Analysis Time Period 
 
TIP. If you are considering analyzing an investment over different time periods, create the analysis with the 
longest time period first because it is far easier to reduce the time period than increase the time period. 
 
Example. 
An organization is analyzing an investment opportunity and wants to carry out a 7 year and 10 year analysis 
 
They would create the 10 year analysis first, and then change the Analysis Time Period from 10 years to 7 years 
and save using “Save As”  
 
If the 7 year analysis is created first, all the revenues and expenses will have to be projected from Year 7 to Year 
10. This involves additional work compared to changing the time period from 10 to 7 years. 
 
Changing the Analysis Time Period 
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Changing the Starting Date and Date Format 

 
There are two formats for the Starting Date; 
 

1. Year 1 Jan, Year 1 July etc. 
2. 2006 Jan, 2006 July etc. 

 
To set the Date format go to the Project Info Folder and click on the “Change Entry Information” Button to display 
the Date format options 
 

. 
Set the preferred Starting Date and preferred format. As an example; 
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The “Starting Date” and “Date Format” being used is displayed in the Project Info folder 
 

 
 
Notes: 
 
The Starting Date and Date format appears on the financial reports. As an example; 
 

  
 

You can change the Starting Date and Date Format at any time and all the reports will adjust to the new Starting 
Date and Date Format. In the example below the Date Format has been changed from  “2011” to the “Year 1” 
format 
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INVESTOR FOLDER 

 

Entries 
Enter the following information; 

1. Investor’s Marginal Tax Rate, Capital Gain Tax Rate and the Recaptured Depreciation Tax Rate. Normally 
the three tax rates are the same, but this is not always the case 

2. The Investor’s Discount Rate or Desired Return on Investment which is used to calculate the Net Present 
Value, Discounted Payback Period etc. 

3. The short term rates for calculating the Modified Internal Rate of Return (MIRR) 
 
Short Term Financing Rate. . If there is a negative cash flow, what would be the short term interest 
rate to borrow the funds? 
 
Short Term Reinvestment Rate 
If there is a positive cash flow what would the short term interest rate be if the funds are invested in a 
short term bank account? 
 

 

 
 
Turn Off Tax Feature 

This feature allows you to remove all the tax inputs from the screens and reports 
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Tax Adjustment Grid 

 

 Allows manual adjustments to the yearly income taxes paid. 
 
To display the Tax Adjustment Grid click on  
 

A positive number increase the income taxes paid for the year 
 
A negative number decreases the income taxes paid for the year 
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INVESTMENT FOLDER 

 

Introduction and Example 
 
The Investment folder is used to enter the initial and future capital investments and set up the depreciation claims. 
 
Steps 
 
1. Enter the Description 
2. Enter Amount 
3. Enter Date. Year & Month 
4. Select the Depreciation Method 
5. Enter the Recovery Period 
6. Additional investments can be added by clicking on the “Add” button which adds another row.. 
 

 
 
Completed Investment Folder example. 
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Inflate Button 
 
Allows you to calculate and enter a future value. 
 
Example. It is anticipated a major component will have to be replaced in five years. The cost today $3,000,000 
what is the cost at 5.00% compounding per year for five years? The Depreciation method is Personal Prop. St 
Line. 200% DB with a 7 year recovery period. 
 
Steps 
 
1. Add row and enter the description “Replacement of Major Component” 
2. Enter the Amount $3,000,000 and set date to Year 2014 
3. Select Depreciation Method “Personal Prop. 200% Recovery Period” 
4. Enter the Recovery Period of 7 years 
5. Click on the “Inflate” Button 
6. Complete the Inflate Dialog and click on ‘OK” 
 

 
 

The completed entries.  
 
The “Inflate” feature calculated the Future Value for $3,000,000 compounding at 5.00% for 5 years which is 
$3,828,845. 
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Depreciation Recovery Periods 
 

Following are the IRS MACRS Property Classifications and Recovery Periods  
 
MACRS refers to the “Modified Accelerated Cost Recovery System” 
 

 

Applicable Property  

 

 

Depreciation Method 

 

Recovery Period 

Short-lived assets Personal Property 200% DB  3 years 
Computers, automobiles, light 
trucks 

Personal Property 200% DB  5 years 

Most manufacturing equipment, 
except long life equipment 

Personal Property 200% DB  7 years 
 Long life 10 years 

Sewage treatment plants , 
telephone distribution plants 

Personal Property 150% DB 15 years 

Sewer pipes and certain other very 
long lived equipment  

Personal Property 150% DB 20 years 

Residential Rental Properties Residential Prop. St Line 27.5 years 
Commercial Real Estate Commercial Prop. St Line 39 years 

 
Half Year & Mid Month Conventions 
 
Personal Property 200% and 150% DB methods use the “Half Year” convention which assumes that all assets 
are placed in service in the middle of the year. This means that only 50% of the allowable depreciation is claimed 
for the first year. The remaining half year is taken in the year following the recovery period. If the asset is sold 
before being fully depreciated the half year convention is applied in the year that the asset is sold. 
 
Mid month convention for real estate. The straight Line Depreciation method is used and the mid month 
convention applied. As an example, if the property was purchased in March, the depreciation claimed is 9.5 
months for year 1.  If the property is sold, then the depreciation claimed in that year must take into account the 
number of months the property was owned during the year of disposal. 
 
The “Mid Year” and ““Mid Months” conventions are automatically applied by Investit Decisions when calculating 
the depreciation schedules. 
 
Declining Balance Depreciation Method 

The depreciation of plant and equipment, called personal property, used the 200% or 150% Declining Balance 
methods. Initially the depreciation is calculated using the Declining Balance Method and then switches to Straight 
Line. 
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The following Depreciation Schedule shows the application of the Mid Year Convention and the switch from 
Declining Balance to Straight Line Depreciation. 
 

 
 
Note: The Recovery Period is 7 years but the depreciation occurred over 8 years because of the “Mid Year” 
convention. 
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WORKING CAPITAL FOLDER 

 

Introduction 

Working Capital is investment or money tied up in inventory, work in progress, accounts receivables etc. 
 
Repayment of Working Capital 

The balance in the Working Capital Account at the end of the Analysis Period is automatically paid down in the 
last month of the Analysis Period. 

 
Example. 
Working Capital addition: 2010 March is $200,000 
Reduction in Working Capital: 2010 May is $35,000 
 
Balance in the Working Capital account is $200,000 – 35,000 = $165,000 
 
If no more additions or deductions are made to the Working Capital, the $165,000 balance will be automatically 
paid back in the last month of the Analysis Period 
 

 
 
The repayment in the last month of the “Analysis Period” of the $165,000 balance in the Working Capital Account 
can be seen in the Net Cash Report. 
 
Example 

 
 
Tax Implications 

Working Capital does not affect the tax calculations but does affect cash flows and financial returns such as the 
Internal Rate of Return (IRR) and the Net Present Values (NPV). 
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EXPENSES & REVENUE FOLDERS 
 
Introduction 
This section provides a brief introduction on how to enter and project revenues and expenses using the 
Projection Wizard. For this brief introduction we will use; 
  

1. The Expenses Folder. The Revenue Folder entries and projections work is a similar fashion. 
2. A “Yearly” Template because the entries and projections are simpler than a “Monthly” template 
3. Template “Invest Revenue & Expenses Yearly” 

 
For a comprehensive guide on how to use Projection Wizard go to the Investit Online Learning Center and print 
out the Investit Decision Guide “Using Projection Wizard” 
 
Expense Folder is used to enter and project expenses 

 
 
There are two types on entries; 

 
1. Entries that can be projected using “Projection Wizard” 

Example: Labor Year 1 $230,000 per Year increasing at 3.00% compounded  
 

2. Single entries which can be made directly in the grid.  
      Example; Materials Year 1 $0 Year 2 $91,000 Year 3 $106,000 Year 4 $10500 which can be entered 

directly in the grid 
 

The example below shows these entries in the Expenses Folder. 
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Example of a projection for the Labor costs made using Projection Wizard and Single Entries for the Material 
Costs 
 

 
 
 
Projection Wizard 

 
Projection Wizard is used to quickly enter and project expenses and revenue 
 
The entry and projection options available in Projection Wizard allow you to quickly enter any kind of projection, 
no matter how complex. 
 
VERY IMPORTANT NOTE 
The key to using Investit Decisions is learning to use Projection Wizard. It is the heart and soul of Investit 
Decisions. 
 
Following is a quick demonstration of Projection Wizard. To learn more about the extensive Projection Wizard 
features print out the “Projection Wizard Instruction Manual” on the Investit Online Learning center and then enter 
the practice examples.  
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The quickest way to see how Projection Wizard works is to enter or follow this example;  
 
Template:  Invest Revenue & Expenses Yearly 
Analysis Period:  10 years 
Folder:  Expenses 
Description:  Labor 
Entry Choice:  $ per Yr 

Projection: $230,000 per Yr then increasing at 3.00% per year compounding until the end of the  
10 year Analysis Period 
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Select the template Invest Revenue & Expenses Yearly 

 
 
Enter the Analysis Period 

 
 
Select the “Expenses Folder” and select the “Labor” row. Click on the Projection Wizard button which takes you to 
the Projection Wizard. 
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Following are the entries in Projection Wizard. 
 
Note: You can view a description of the projection by clicking on the “Projection Description” button 
 

 
 
LEARNING PROJECTION WIZARD IS THE KEY TO USING THE FULL POWER OF INVESTIT DECISIONS  
 
To learn the full capabilities and features of Projection Wizard, print out the “Projection Wizard Instruction Manual” 
available on the Investit Online Learning Center and then follow and enter the practice examples. 
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Using the Expenses & Revenue Folders 

 

Complete the “Revenue & Expense Folders” using the following steps; 
 

1. Select the row or add a new row and enter the description 
2. Select the Entry Choices (see explanation below) 
3. Certain Entry Choices require the Quantity to be entered 
4. If appropriate, select the Category (See explanation below) 
5. Use Projection Wizard to make the entry and projections  

 

 
 
Entry Choices  

 
Entry Choices allow you to choose the “Unit of Measure” to be used. 
 
As an example, $ per Yr, $ per Mo, $ per Ton, $ per Patient etc 
 
You can also create you own Entry Choices. Some examples; 

$ per Pump (Pump manufacturer) 
$ per Bed per Day, $ per Patient (Hospital) 
$ per Applicant (Government agency) 
 

The abilty to create you own “Entry Choices” allows you to adapt a template to your own needs and then save as 
“My Template” 
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Investit Templates come pre-loaded with common Entry Choices 
 

 
 

Special Entry Choices. $ per Unit &Quantity & % of Revenue(s) or Expenses 

 
Following is an explanation of three Entry Choices which have unique characteristics; 
 

1. $ per Unit & Quantity 
2. % of Revenues(s) 
3. % of Expenses(s) 

 

$ per Unit & Quantity Entry Choice 

 
This Entry Choice is used when the “Price or Cost per Unit” and the “Quantity” changes over time  
 
In the example below the “Price per Unit” and “Quantity” sold change over time 
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% of Revenues(s) & % of Expenses Entry Choices 
 
The Entry Choice “% of Revenue(s)” allows you to make an revenue a “% of selected revenues” or a “% of 
selected expenses” 
 
The Entry Choice % of Expense(s) allows you to make an expense a “% of selected revenues” or a “% of selected 
expenses” 
 
Example: 
 
The Sales Commission Expense is 7.00% of Sales 
 
Select the Entry Choice “% of Revenue” and then select the revenues to which the sales commissions apply. 
 

 
 
The Sales Commission is 7.00% of the sales revenue for Product A & B 
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Editing the “% of Revenue(s)” list. (Same applies for editing the “% of Expenses List”) 
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Creating your own Entry Choices 

 
New “Entry Choices” are set up separately for the Revenue and for the Expenses folders.  
 
 
Example No. 1: Add the Entry Choice “$ per Sq. Meter per Mo” to the Expenses folder. 
  
1. On the Entry Choice List select “Edit List” to display the “Add Entry Choice” dialog 
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2. On the “Entry Choice List” click in the Add button to display the “Add Entry Choice” dialog and set up the  
Entry Choice “$ per Sq. Meter  per Mo” and click on the “OK” button. 

 

 
 
Example No. 2  
A manufacturer of water pumps want to add an Entry Choice “$ per Pump & Quantity” in order to enter the labor, 
material and overhead costs as “$ per Pump” 
 
Go the Expense Folder and display the Entry Choice List and select “Edit List” and the click on the “Add” button. 
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Create the Entry Choice “$ per Pump & Quantity” and click “Ok” 
 

  
 
The new Entry Choice “$ per Pump & Quantity” have now been added to the Entry Choice List 
 

 
 
Rearranging the Entry Choice List & the Default Entry Choice 
You can Add and Delete Entry Choices and rearrange the ordering of the list using the Move Up” and “Move 
Down” buttons. 
 

Important Notes:  
 
1. The Entry Choice at the top of the list is the Default Entry Choice.  
 
2. If you add a row in a grid, the new row will show the Default Entry Choice which is the first Entry Choice in 

the Entry Choice List 
. 

3. Entry Choices that come  with the template cannot be edited or deleted 
 
The new Entry Choice $per Pump & Quantity” has moved to the top of the list and becomes the Default Entry 
Choice. 
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When a row is added the Entry Choice at the top of the list is displayed. In this case “$ per Pump & Quantity” 
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Revenue & Expense Categories 

 
Categories can be used to group revenues and to group expenses. 
 
We will add the following three Expense Categories 
 

1. Manf. Costs 
2. Assembly 
3. Overhead 

 
Go the Expense Folder and display the Category List and select “Edit List 
 

 
 
Click on the “Add” button to add the category “Manf. Costs” and click on the ‘OK” button. 
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Repeat the process to add the “Assembly” and “Overhead” categories 
 
The three new Categories have now been added to the Category List 
 

 
 
The following example shows the expenses broken down by “Category” 
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FINANCE FOLDER 

 
Preface 

The Finance Folder allows you to enter the financing for capital investments in equipment, real estate etc., if 
appropriate. 

In capital budgeting, financial and engineering economic analysis it is common to ignore financing as this is an 
organizational decision. The organization rarely borrows to fund an individual investment in equipment and other 
assets. Instead, money is raised through retained earnings, the issuance of shares, bonds, debentures and bank 
loans etc. If this is the case the Finance Folder is not used. 

The organization may decide to lease rather than buy the equipment. The Investit Decision’s templates “Lease” 
and “Buy” can be used to decide whether to lease or buy the equipment. 

Only use the Finance Folder if there is loan being borrowed against the specific investment or the investment 
involves the acquisition of real estate funded by a mortgage registered on the property.  
 

Also used to enter finance such as equipment loans, mortgages etc that apply to the specific project being 
analyzed. 
 
In most cases investments are funded internally by the organization from money raised from retained earnings, 
issuance of shares and bonds etc. If this case the Financing folder is not used. 
 
Features 
 
The Financing Folder is used to create mortgages and loans and offers the following features which allows you to 
enter any kind of mortgage or loan and explore creative financing options 
 
1. The financing can start and finish at any time  
2. The number of mortgage or loans is unlimited 
3. Choose Fixed” or “Variable” interest rates 
4. A full range of mortgage types are available 
 

 
 
5. Additional Payments & Borrowing can be made at any time 

 
6. Payment Frequency can be changed 
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7. Compounding Frequency can be changed 
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To learn more about the financing folder and how to set up different types of loans go to the Investit Online 
Learning Center and print out the Instruction Manual “Finance Folder. Creating Mortgages & Loans” 
 

 
 
Example 
Following are the entries for a standard mortgage or loan. 
 
Mortgage Details 

Start Date: 2010 March 
Type: Standard Mortgage (Fully amortized loan with constant monthly principle and interest payment) 
Amount: $3,000,000 
Description: Financing 

Mortgage Settings 
Payment Frequency: Monthly 
No additional payments or borrowing 
Payments: Rounded to Nearest Cent 
Compounding Frequency: Monthly 

Term and Amortization Details 
No. of Terms: 1 
Time Period: 7 years (Mortgage is paid off with a balloon payment at the end of 3 years) 
Amortization Period: 7 
Interest Rate: 7.000% 
 
After making the entries click on the “Compute” button and then the “Ok” button to complete the mortgage 
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SALVAGE VALUE FOLDER 
 

Introduction 
Used to enter the salvage or terminal value of the asset(s) plus associated disposition costs such as selling 
expenses, legal fees, clean up costs etc. 

  
Steps 

 
1. Enter disposition costs such as selling expenses, legal fees, clean up costs etc 
2. Enter the salvage value of the asset. Note: The salvage value could be negative. 
 
Income Tax Adjustment 

 

Allows manual adjustment to the income taxes paid on disposition of the asset 
 
A positive entry reduces the taxes paid on disposition 
A negative entry increases the taxes paid on sale 
 
Example: 

Entry: $150,000 will reduce the taxes paid on disposition by $150,000 
Entry: -$56,000 will increase the taxes paid on disposition by $56,000 

 
The results can be viewed on the “Cash Flow on Disposition” report 
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REPLACEMENT DECISIONS (KEEP or REPLACE) UNIQUE FEATURES 
  
Introduction  

 

A common Investit Decision is the replacement decision. Should the organization keep repairing an asset or 
replace the aging asset with a new asset. The “Keep” and “Replace” templates have some unique inputs that are 
explained in this section. 
 

 
 
 
Keep or Replace Decision. Examples 

 
A city needs to decide whether they should keep repairing an old wooden bridge or replace it with a new wooden, 
steel or concrete bridge? 
 
A hospital has an x-ray machine that keeps breaking down. Should they invest in a new x-ray machine? 
 
A company purchased equipment to manufacture circuit boards five year ago. New, more automated equipment 
which is more reliable in now available for $5,000,000 installed. Investing in the new equipment will result in less 
down time, fewer rejected circuit boards and will provide increased production capacity and sales revenue. 
Should they investit $5,000,000 in the new equipment?  
. 
 



 72

Keep Template. Investment Folder 

 
There are two types of investments in “Keep” analysis which are entered in the Investment folder. New & Existing 
Investments. Existing or historical investments are also referred to as “Preexisting Investments” 
 

 
 
 

Preexisting Investments 

Preexisting investments are historical investments that were made prior to the Analysis Start date.  
 
The preexisting investment is not relevant to the analysis and does not appear in the cash flows or financial 
calculations because it is a sunk cost and therefore not relevant to the decision. 
 
However, the remaining depreciation claims related to the preexisting investment and the salvage value of the 
asset at the end of the Analysis Period is relevant to the “Keep” analysis. 
 

As an example, the equipment that is being considered for replacement was bought four years ago for 
$4,000,000. The depreciation method was Personal Property 200% DB with a 7 year recovery period. This means 
that there are 3 years of depreciation left to claim. This is the Recovery Period of 7 years less the previous four 
years. 
 
Note: Personal Property uses the mid year convention which means that for a recovery period of 7 years the 
depreciation is claimed over 8 years and therefore the remaining years left to claim depreciation is 4 years when 
the mid year convention is applied. 
 
 The $4,000,000 historical investment made four years ago is not relevant to the “Keep” decision.  
 
What is relevant is; 

 
a) The remaining depreciation claims for 4 years including the application of the Mid year convention in the fourth 
year 
  
b) The “Salvage Value” of the equipment at the end of the Analysis Period 
 
The original investment of $4,000,000 four years ago does not appear in the cash flow reports because it is a 
“sunk” or historical cost and not relevant to the Keep Decision. 
 

New investments 
Investment made at the start or during the Analysis Period which appear in the cash flow reports. As an example, 
$350,000 is spent on a major overhaul of the existing equipment in Jan Year 3. The depreciation method is 
“Personal Prop. 200% DB 7 year Recovery Period” 
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 Entering Preexisting and New Investments. Example 

 

The entries in the Investment Folder entries will be explained using an example 
 
Example 
 
Template: Keep Expense Only Yearly 
Analysis Period: 10 years 
 
Preexisting Investment:  
Investment. $4,000,000 purchased 4 years ago. 
Time: Four years before the Analysis Start Date. 
Depreciation Method: Personal Property 200% DB with a 7 year recovery period 
Remaining Recovery Period: 3 years 
Salvage Value at the end of the Analysis Period: $350,000 
 
New investment 
It is anticipated that an additional investment to overhaul the equipment will have to be made Year 3 Jan. 
 
Investment. $350,000 
Time: Jan Year 3   
Depreciation Method: Personal Property 200% DB with a 7 year recovery period 
Salvage Value at the end of the Analysis Period: $180,000 
 
Steps 
 
1. Select the “Keep Expenses Only Template” 
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2. Enter the 10 year analysis Period 
 

 
 
3. The Preexisting Investment is entered by; 
 

1. Select the row.” Existing Equipment” 
2. Select the depreciation Method 

3. Click on “Investment Exists” in the last column  
4. Click on “Edit Existing Depreciation” Button 
5. Complete the “Preexisting Investment” screen and click on the compute button. 

 
The steps for entering a Preexisting Investment are shown in the diagram below. 
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Entering the Preexisting Investment 
 

 
 
The completed entries for the “Preexisting Investment” 
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Entering the New Investment 
 
New investment 

Investment:. $350,000 
Time: Jan Year 3   
Depreciation Method: Personal Property 200% DB with a 7 year Recovery Period 
 

Entering the “New” investment is the same processes for all templates. The steps are; 
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Keep Template. Finance Folder 

 
There are two types of mortgages or financing in “Keep” analysis which are selected in the Financing Folder. 
 

Preexisting Financing 
 

Financing that was arranged to purchase the asset which is being considered for replacement.  
 
As an example, the equipment that is being considered for replacement was financed 4 years ago with a bank 
loan for $400,000 amortized over 10 years at 7.00% interest. 
 
The Outstanding Balance on the Analysis Start date is $272,411 
Remaining Amortization Period: 6 years 
 
What is relevant to the Keep Decision are the principal and interest payments occurring during the Analysis 
Period, not the original $400,000 loan. 

 
The information needed to set up the “Existing Mortgage” is; 

a) The outstanding balance of the existing mortgage or loan on the Analysis Start Date: $272,411 
b) Remaining Amortization Period: 6 Years 
c) Time Period: Which is equal to the Analysis Period unless there is a balloon payment 

 
Preexisting Mortgage entries. Example 
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New Financing 
 

Refers to the financing of the replacement asset. 
 
Select the “New Mortgage” option and enter the mortgage or loan information. For more details see the Finance 
Folder section. 
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Replace Template  
 
In “Replacement Decisions” we need to enter the before and after tax Salvage Value of the equipment being 
replaced plus repayment of any financing or loans associated with the assets or equipment being replaced. 
 
The “Salvage Value” is the revenue generated from the sale of the equipment less removal costs. 
 
Note. The Salvage Value can be negative if the revenue generated by the sale of the equipment being replaced is 
less than removal costs. 
 
Example: 
 
A company is considering replacing an old steam generator with a more energy efficient model. 
 
The new model will cost $7,000,000 installed. 
Depreciation is Personal Prop. 200% DB Recovery Period: 7 years  
 
Salvage Value of the existing equipment is $800,000 before tax and $680,000 after tax. 
 
Original financing.  
The purchase of the equipment being replaced was financed by a bank loan of $1,200,000. The current 
outstanding balance is $550,000 which must be paid off if the steam generated is sold. 
 
The entries in the Replace Expenses Only Yearly template Investment Folder are; 
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CUSTOMIZING TEMPLATES 
 

Introduction 
You can quickly customize a template to your own requirements and save as “My Template” 
 
The following components can be customized; 
 

1. Investment, Revenue, Expenses & Salvage Folder grids by; 
• Adding, moving, inserting & deleting rows 
• Changing Descriptions 
• Selecting Entry Choices 

 
2. Adding new Entry Choices  

 
3. Adding Revenue & Categories 

 

Creating and saving a new template  

 
1. Open the appropriate Investit template 

 
2. Modify the Folders to your requirements, such as; 

Add new rows & descriptions in the Investment, Revenue & Expenses Folders    
Create new Entry Choices in the Revenue and Expense folders   
Create new Categories in the Revenue and Expense folders    
 

3. Go to the Report Menu and select “Save As Template” 
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My Templates 
 
Your customized templates are located in the “My Templates” folder on the Investit Panel  
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Renaming & Deleting My Templates 

 
File Menu allows you to “Delete” and “Rename Templates” 
 

 
 

Customized Template Example 

Open the ‘Investit Examples’ folder and select “Customizing a Template Example.  
 

 The step by step instructions for this example is available on the Online Learning Center. 
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GRAPHS 

 
There are a number of graphs that displays the financial results visually 
 
To view these graph open up an Investit Example. 
 
1. From the Report Menu select the Graph to view 
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Operating Cash Flow 

This graph shows how the Operating Cash Flow changes over time. It is very useful graph for spotting errors in 
your entries and projections.  
 
TIP: After entering a Project view the Operating Cash Flow graph to see if the entries and projections appear to 
be correct. 

 
 
Example showing an entry and projection error 

 
The graph below illustrates a mistake was made in 2014 in the revenue projections which need to be corrected.   
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Graph: Present Value vs. Investors Desired Return or Discount Rate 
 
This graph allows you to determine the investment that will provide the desired Internal Rate of Return (IRR).   
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 FILE MENU 
 
This section reviews the File Menu operations 
 

New Project 

 

 
 
Selecting “New Project” displays the Template List. To open a “New Project” select the appropriate Template. 
 

 
 
If you have a project open you will be asked if you want to save the Project. 
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Open Project 

 

 
 
Displays the Saved Project list. Select and open the desired project.  
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Close Project 

 

 
 
Closing the project returns you to the Investit Panel. You will be asked if you want to save the Project. 
 

 
 

If the project is new and hasn’t been saved, you will be asked to give the project a name. You can also enter a 
description of the project. 
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Rename Project 
 

To rename a project you need to have a project opened. 
 
Select “Rename Project” on the File menu 
 

 
 

Select the project and change the name. 
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Delete Projects 

 

To delete a Project you need to be on the Investit Panel 
 

 
 
1. Go to File menu and select “Delete Projects” 
 

  
 
2. Select projects to be deleted and click on the “Delete” button 
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Save Project & Save Project As 
 
Once you start a project you use “Save” to give the project a name and save the project 
 
Steps 
 
Select “Save” from the File menu 
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Give the project name and save. You can also enter a description of the project 
 

 
 

 
Using “Save As” 

 

You may wish to run different scenarios for the project. As an example; 
 

• Optimistic Forecast. Run 1. 
• Medium Forecast. Run 2 
• Pessimistic Forecast Run 3 

 
1. Use “Save As” to create a duplicate project but with a new project name 
2. Make the desired name changes 
3. Save using “Save” 
 



 93

Save as Template 

 
To save a template that you have modified to suit you own needs. 
 
Select “Save as Template” on the File menu, name and describe the template and save as follows; 

 

 
 
 
On the Investit Panel “My Templates” folder we have added a Template called “Jersey Division Outsourcing 
Template” 
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Rename Template 

 

To rename a “My Templates” 
 
1.   Select and open the template to be renamed 
 

Note: You need to have “My Templates” open in order to rename a template 
 

 
 
2. Select template to renamed, enter the new template name, modify the template description and click “Ok” 
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Delete Templates 

 

To delete a Template hat you have saved under “My Templates” you need to be on the Investit Panel. 
  
1. Open the Investit Panel, select “Delete Templates” on the Report menu 
 

 
 

2. Select the template to be deleted and click on the Delete button 
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Import/Export 

 

Allows you to transfer “Projects” and “Templates” between computers that have Investit Decisions installed. 
 
1. Go to the File menu select Import/Export 
 

 
 

2. Select Import/Export to display the Import/Export Wizard 
 

 
 

3. Select the activity and click on the “Next “button. For this example we will use the “Export” option. 
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4. Select the Projects to be Exported and click on the “Export” button 
 

 
 

 
5. Using the Windows Browser name the “File” and save to the desktop or select a “Folder” using the Browser. 

 
6. You can now e-mail the projects you have Exported. 
 
Follow the same procedure to transfer “My Templates “ 
 
Duplicate Project or Template Names 

 
If you attempt to import a Project or Template that has the same name as one saved on your computer the 
Duplicate warning message will be displayed offering you several options. 
 
Replace the Project or Template saved on your computer with the imported project 
 
Import the duplicate but modify the Name by adding (1) to the end of the imported project or Template name.  
 
As an example if the Project name is “New Jersey Expansion” the imported Project becomes “New Jersey(1)” 
 
Note:   The imported file may contain several duplicate Project or Templates. You can apply your selected option 
to all the duplicate Projects or Templates by clicking on the check box 
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Importing a Company Logo 

 
Following are the steps for importing your company logo. Acceptable file formats are; 
 

.png   .jpg  .gif 
 
1. Select “Company Logo” on the File Menu then click on the “Add” button 
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2. Locate and select the logo and click on the “Open” button 
 

 
 

3. Click on the “Ok” button 
 

   
 
The company logo is now displayed on all reports 
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Project Images 

 

You can import a photograph and display it on the Title Page 
 
1. Open the Project that you wish to add the image to the Title Page and select Project Images from the File 

menu. Click on the Add button to add the image 
 

 
 
2. Locate, select and open the image 
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3. Locate, select and open the image. The image will now print on the Title Page 
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EDIT MENU 
 
Used to access and edit; 
 
1. Company Logo and Images 
 
2. Copy and paste Client information from one project to another 
 

 
 

Copy & Paste Client Information 

 

You can copy or transfer the Client Information Folders from one project to another. This saves re-entering the 
Client information. 
 
1. Open the Project which has the Client information you wish to Copy 
2. On the Edit Menu select “Copy Client Information” 
 

 
 

Open a New Project or an existing Project that you wish to transfer the Client information to. 
Complete the transfer by selecting “Paste Client” information from the “Edit” list 
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UTILITIES 
 
Use to back up and restore your projects and templates 
 

 
 
Auto Update 

Use Auto Update to check if you have the latest update 
 

Backup/Restore 

 
Backup is used to make a copy of the whole data file containing all user projects and templates to a storage 
device such as CD, zip drive or other external storage device. Restore is used to replace an existing data file 
containing all user projects and templates with the one that was generated with the Backup routine.  

Process: Backup the whole data file containing all user projects by selecting Backup from the Utilities Menu or by 
using the Backup/Restore button on the Navigation Panel. Then restore all user projects and templates from the 
backup data file to another or the same computer installed with Investit Pro by selecting Restore from the Utilities 
Menu or by using the Backup/Restore button on the Navigation Panel.   
NB:  All existing files on the destination drive will be overwritten. 

Backup  

1. Click on Backup button 

 

2. Click the button for action to be performed. i.e. Backup.  
3. In the Save dialog box insert destination drive or location e.g. desktop or CD Rom drive. 
4. Name the file and Click Save to complete the process 
5. A confirmation of a successful backup should then be received. 



 105 

Restore  

1. Click Utilities Menu / Backup/Restore or the Backup/Restore button on the Navigation Panel 
 

 
 
2. Click the button for action to be performed i.e. Restore  
3. In the Open dialog box locate the file containing the previously backup file. 
4. Click Open to complete the process. 
5. A confirmation of a successful restore should then be received. 
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DEFINITIONS & FORMULAS 
 

Benefit to Cost Ratio (Before Tax) 

Also called the “Profitability Index” 

 =  Benefits 
      Costs 

 
 
Where; 
  

PV is the Present Value based on the Discount Rate entered in the Investment Folder 
Net Income = Revenue – Expenses 
Financing is excluded from the calculation 
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